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Clarification of notation 

NOTE:  
This type of paragraph calls readers attention to a notice or related theme. 
 
CAUTION!  
This type of paragraph highlights a procedure, adjustment etc., which can cause a damage or 
unproper function of the equipment if not performed correctly and may not be clear at first sight.  
 
WARNING!  
This type of paragraph indicates things, procedures, adjustments etc. which need high level of 
attention, otherwise can cause personal injury or death.  
 

http://www.comap.cz/
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General guidelines 

What is InteliMonitor? 

InteliMonitor is Windows 2000/XP/Vista/Win7 based software which provides following main functions:  

 Online monitoring of a controller or site - single line diagram  

 Special fullscreen SCADA mode  

 Browsing of all measured and computed values 

 Browsing of controller history records  

 Adjusting setpoints 

 Receiving acive calls 

NOTE:  
InteliMonitor supports InteliGen-NT®, InteliSys-NT®, InteliMains-NT®, InteliLite-NT®, InteliPro®, 
InteliCompact-NT®, MainsCompact-NT®, InteliGen Classic and InteliSys Classic controllers.  

Installation 

Execute the "ComAp PC Suite" installation package (e.g. IGS-NT-Install-Suite-2.4.exe) to install 
InteliMonitor, controller firmware and other components into your computer. If there is InteliMonitor 
already installed, the installation program will offer an upgrade (if your current version is older) or re-
installation (if your current version is identical). 

If your current version is older, then it is recommended to perform the upgrade, as the controller 
firmware, that you are about to install, may not be compatible with older InteliMonitor version. 

InteliMonitor directories 

 
INTELIMONITOR DIRECTORY STRUCTURE 



 

InteliMonitor, SW version 3.0, ©ComAp – June 2013                                              6 
Intelimonitor-3.0-Reference guide.pdf 

PC Hardware requirements 
InteliMonitor is based on Windows 2000/XP/Vista/Win 7 platform. Use PC suitable for this platform. 
There are no special requirements for the PC hardware. 

File types and extensions 

InteliMonitor works with following file types (extensions): 

FILE EXTENSION FILE TYPE DESCRIPTION 

*.ANT 
IGS-NT 
archive 

Archives contain setpoints, values, history and configuration 
saved from the particular controller. Archives are located in the 
genset folder. See also the Sites chapter.  

*.AIG 
IG-Classic 
archive 

*.AIS 
IS-Classic 
archive 

*.AIL IL-NT archive 

*.AIC IC-NT archive 

*.AST Archive set 

Archive sets are located in the site folder and contain links to 
archives from all active gensets of the site which were saved at 
the same time. Archive sets are created by Save all or Save all 
as functions and used by Multi-offline connection.  

*.ZST 
Zipped 
archive set 

Zipped archive sets are used for sending of complete archive 
sets to the ComAp technical support. 

*.CWD 
Single-line 
diagram 
drawing. 

 

*.CWS 
Control 
window 
definition file. 

 

How to check version? 

Use Help->About to display window with current InteliMonitor version. 
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Working with InteliMonitor 

InteliMonitor is a tool for monitoring and adjustment of a controller. It can be either connected online to 
the controller or can work offline with previously saved archive(s). 

Single vs. multiple connection 

InteliMonitor allows connection to one single controller or to the whole site at one moment. A 
connection to one controller is called single, connection to the whole site at one time is called multiple. 
The program behavior is slightly different in these two modes. 

NOTE:  
The connection is handled as multiple even if the particular site contains only one gen-set. 
 
The main differecies are:  

 The background of the main InteliMonitor window displays the single-line diagram 
("multicontrol" window) in multiple connection. In single connection it is blank.  

 The appearace of the toolbar panel is different. In the multiple connection there is a set of 
buttons for selection of the particular controller together with a button activating the pull-down 
menu containing functions related to the particular controller.  

 In multiple connection the menu Monitor is always related to the currently selected controller.  

 
INTELIMONITOR MAIN WINDOW IN SINGLE CONNECTION 
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INTELIMONITOR MAIN WINDOW IN MULTIPLE CONNECTION 

 

Connection to the controller 

Go to the menu Connection -> Open connection or click to the icon   to display the open 

connection dialog window. 

Using sites 

The philosophy of the program is to use data structures that fit to the real situation in the field. That is 
why a system of folders, called Sites and created according to real structure of the user's applications, 
is used for storage of all user data. 
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The root directory, which is located in the "ComAp PC Suite" subfolder of the Windows shared 
documents folder, contains subfolders, where each of them represents one site. Each of these "site" 
subfolders contains next level of subfolders, where each of them represents one genset and contain 
data of the particular genset. 

NOTE:  
All the folders mentioned above are created by the InteliMonitor when a site or genset is created in the 

Open connnection window. There is no need to create them manually using a file manager like 

Windows Explorer.  
 

 

 

Create a site 

1. Select the radiobutton (1) to switch the connection window into "Sites" mode. 
2. Use the button (2) to add a site. Enter a suitable name into the dialog window that appears 

after the button is pressed. 
3. You may use the button (14) to import whole site from a ZIP file into which the site was 

previously exported by using the button (15). This function may be helpful when a site is to be 
transferred from one computer to another one.  

4. Use the button (3) to add a gen-set into the site. Enter a suitable name into the dialog window 
that appears after the button is pressed.  

5. Select the controller type in the field (4).  

NOTE:  

Select IGS-NT type for IM-NT, IC-NT type for MC-NT, IG for IM-Classic and IL-NT for IA-NT. 

 

6. Enter the controller address into the field (5). The controller address must be unique for each 
controller within the site and must correspond to the ControllerAddr setpoint in the controller.  

7. Enter the controller access code int the field (6). The access code is not required for direct and 
offline connections.  

8. Enter controller password into the field (7) - optional field. 
9. In case of IGS-NT controller enter user name the password is valid for - optional field. 
10. In case of Internet/Ethernet connection enter the index of the IP address to which the 

controller is connected into the field (9). This field is required for Internet/Ethernet connection 
only.  
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11. You can disable the communication with a certain controller temporarily by unchecking the 
box (10). Use this function to avoid communication errors when a controller is switched off e.g. 
because of maintenance works.  

12. Click to the button (12) to open site properties dialog, where you can adjust properties needed 
for proper generation of the default single line diagram.  

13. The buttons (11,13) open a dialog windows where notes for the selected site and/or genset 
can be made. These notes are stored in plain text files in the site resp. genset directory.  

14. Use the button (15) to export an existing site into a ZIP file. You can export the complete site 
as well as only archives or only Single line diagram files. This export function is intended for 
transferring complete site or particular data to another computer or e.g. for sending it to the 
Technical support.  

 
CREATE SITE 

 

Site properties 

This dialog is used for entering information needed for proper generation of the default single line 
diagram. 

 Check the box (1) to show the "mains" panel at the very left position of the single line diagram. 
The panel contains the mains sybmol and additionaly it can contain also MCB and InteliMains 
objects.  

 Check the box (2) if you do not have mains controller (InteliMains, MainsCompact) and you 
want to show the MCB in the mains panel. The information of MCB position is taken from the 
controller with address adjusted in the field (4).  

 Check the box (3) if you have a mains controller in your site and you want to show it's panel in 
the single line diagram. Adjust the mains controller address in the field (4).  

 Check the box (5) to show the "mgcb" panel in the left part of the diagram. This panel can be 
dispalyed only if there is a mains controller with MGCB application in the site.  

 Check the box (6) to show the "load" panel in the left part of the diagram. The panel contains 
the "house" symbol and can also contain analog meters with several different values related to 
the object load.  

 Check the box (7) to show the analog meter with the total genset power. 
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 Check the box (8) to show the analog meter with current reserve. 

 The field (9) is used for adjusting controller address from which the reserve and total genset 
power values will be read. 

 If you use the default single line diagram (e.g. generated by the InteliMonitor), then normally 
the diagram is automatically regenerated every time you connect to the site. This ensures the 
diagram will always reflect all possible changes that were made at the site, however it may 
take certain time. If you want Intelimonitor to generate the diagaram only once and then reuse 
it for all next connections wihout regeneration, check the box (10).  

NOTE:  

One you have edited your diagram manually using the single line diagram, InteliMonitor will 
use that diagram and NOT rewrite it with an automatically generated one.  

 

 
SITE PROPERTIES 
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Connection to a site 

1. Select the radiobutton (1) to switch the connection window into "Sites" mode. 
2. Select the desired site in the left panel (2) or use the field (3) to filter the sites to those that 

contain specified substring. 
3. Select the desired connection type in the right panel (4) and ajdust connection parameters.  

4. Open the connection by clicking to the Open conection button.  

 
CONNECTION TO A SITE 
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Quick connection 

The quick connection is used for fast connection to a single controller without the need to define new 
site and genset. 

1. Select the radiobutton (1) to switch the connection window into the "Quick connection" mode. 
2. Select the desired connection type in the right panel (2) and ajdust connection parameters OR 

open a previously saved connection definition by clicking on the button (3) and then selecting 
desired connection definiton file (*.CON).  

NOTE:  

The same connection definiton file can be used except InteliMonitor also for GenConfig and 
LiteEdit. 

 

3. Once the connection type is selected and connection parameters adjusted, the connection 
definition can be saved by clicking to the button (4) to a *.CON file and used later again.  

4. Open the connection by clicking to the Open conection button.  

 

 
QUICK CONNECTION 
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Receive active calls 
Active calls are modem connections initiated by the controller self when specified event type (alarm 
type) occured in the controller. When the event (or more events in the same time) occurs, the 
controller will dial adjusted phone number, where a PC with InteliMonitor in active calls receiving mode 
must be present, and send an archive to the PC. 

1. Select the radiobutton (1) to switch the connection window into the "Active calls receiving" 
mode. 

2. Select the modem (2), which will be used for receiving of active calls. This modem can't be 
used for any other program such as dial-up internet connection while receiving of active calls 
is running.  

NOTE:  

The modem must be correctly installed in your system to see it in the modem list. See the 
documentation of the modem for more information about how to install it.  

 

3. Select the folder (3), where the incoming archives will be stored. 

4. Start receiving the active calls by pressing the Open conection button.  

 
START RECEIVING ACTIVE CALLS 

 
When you started receiving of active calls, the window with received archive list will appear. The 
window contain a list of received active calls (1) with their filename, date/time and controller serial 
number. The color of the bottom line of the main window (2) indicates current status - green indicates 
that an active call is beeing received, gray means the program is waiting for an incoming call and 
yellow mean the program is preparing for receving calls. 
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ACTIVE CALL WINDOW 

 

Connection types 

There are several possible ways how to connect to a controller in order to monitor or adjust it. These 
kinds of connection are called online. 

Current data from the controller can be in any moment during the online connection saved into a file, 
which is called archive. In addition to the online connections, there is also possibility to open the 
previously saved archive and display the data from the moment when the archive was saved. This 
"connection" is called offline. 

In principle there is no difference between online and offline connections regarding the program 
control and behavior, except the fact, that the data are static during offline connection and some 
functions, which needs the controller to be connected, are disabled. 
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Direct connection 
Direct connection is a cable connection through a serial COM port of the PC and serial or USB port on 
the controller. 

 

 

 

 

 
DIRECT CONNECTION TO A SINGLE GEN-SET 
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DIRECT CONNECTION TO A SITE 

 

1. Click to the button (1) to select direct connection. 
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2. Select the COM port, to which the controller is attached. The port can be either physical 
(physical COM port card in the PC) or virtual (created by the driver of an USB/RS232 
converter).  

3. In the "Quick connection" mode you have to select the controller address in the box (3) and 
optionally enter the controller password in the box (4). However, the password can be entered 
also later while the connection is already running.  

 
DIRECT CONNECTION SETTINGS 

 

Modem connection 

Modem connection is a point-to-point connection between a PC and a controller or site using modems. 
The modems at both sides must be of the same kind, e.g. both analog, ISDN or GSM CSD. 

NOTE:  
Please note, that certain techologies which use "modems", such as GPRS, EDGE, CDMA, UMTS and 
others, are used for dial-up network (internet) connections only and may not support point-to-point 
connection, which is needed for modem connection in InteliMonitor.  
 

1. Click to the button (1) to select modem connection. 
2. Select the modem (2) which will be used for the connection.  

NOTE:  

The modem must be correctly installed in your system to see it in the modem list. See the 
documentation of the modem for more information about how to install it.  

 

3. Enter the phone number (3) of the controller. Use number format suitable for your local 
telephone network, i.e. the same format you would use to dial the number by a phone.  

4. Check the Callback box (4) if you want the connection to be originated from the controller 

side, i.e. the connection fees will be charged to the owner of the controller.  
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NOTE:  

This function is supported only if the controller(s) are connected to the modem via IG-MU or I-
LB(+). 

 

5. If you checked the callback, you have to check the modem callback mode in the box (5) and 
fill-in your phone number (6). 

6. In the "Quick connection" mode you have to select the controller address and access code in 
the boxes (7),(8) and optionally enter the controller password in the box (9). However, the 
password can be entered also later while the connection is already running.  

 
MODEM CONNECTION SETTINGS 
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Internet (Ethernet) connection 

The Internet (Ethernet) connection is a point-to-point connection between a PC and a controller or site 
via an TCP/IP protocol-based network. The physical configuration of such network can be a small 
local area ethernet network as well as the Internet. 

 
CONNECTING A SITE VIA ONE IG-IB/IB-NT MODULE 
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CONNECTING A SITE VIA MORE IG-IB/IB-NT MODULES 
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CONNECTING A SITE VIA IB-LITE OR IB-COM MODULES 

 

1. Click to the button (1) to select internet connection. 
2. If you are using "quick connection", enter the IP address of the gen-set (site) into the field (2). 

In "sites" mode you have to define all IP addresses that are used at the particular site and 
then assign the IPs to the particular gen-sets in the site. Refer to the chapter Create site of 
this manual.  

3. Add/remove IP addresses using the buttons (6), (7). 
4. In the "Quick connection" mode you have to select the controller address and access code in 

the boxes (3),(4) and optionally enter the controller password in the box (5). However, the 
password can be entered also later while the connection is already running.  

 
INTERNET CONNECTION SETTINGS 
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NOTE:  
The IP addresses of the controllers must be accessible from the remote computer. If the remote 
computer is connected into another LAN segment than the gen-sets are, there must be a gateway(s) 
that enable direct traffic between the segments. If the remote computer is connected via Internet, then 
the internet gateway of the LAN where gen-sets are connected must have public IP address, must 
allow incoming traffic and must provide port forwarding from the external public IP to the different 
internal gen-set IPs according to the port used.  
 

 
INTERNET GATEWAY CONFIGURATION EXAMPLE (PORT FORWARDING) 
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Internet connection via AirGate server 

This connection type is used for connection to controllers/sites, that are connected to the Internet, 
however they do not have public and static IP address. The controllers connect by themselves to the 
AirGate server and cyclically ask whether there is a connection request from a client or not. On the 
other side the clients (InteliMonitor) connect to the AirGate server and instead of connecting directly to 
the controller. The server then creates a "tunnel" between the client and the controller. 

CAUTION!  
To avoid unauthorized access to the controller change the access code and keep it secret! 
 

 
PRINCIPLE OF AIRGATE CONNECTION 

 
NOTE:  
The controller firmware and/or communication module must support the AirGate connection type. 
 

1. Select the AirGate connection type. 
2. Fill-in the correct AirGate ID for each controller. The AirGate ID is displayed on the controller 

screen when the controller has connected at the AirGate server. The ID is assigned to the 
respective controller by the server in the moment of the registration and remains the same in 
any time the controller connects to the server again.  

3. Enter the AirGate server address. Use the same server as in the controller. 

NOTE:  
There is a public free AirGate server at "airgate.comap.cz".  
 
NOTE:  
Although the controllers in your site are not connected together by the CAN2 bus they must have 
different controller addresses (4).  
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AIRGATE CONNECTION SETTINGS 
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Offline conection 

An offline connection displays data from a previously saved archive or archive set.  

 Archive is a file with different extensions (".aig", ".ais", ".ant"..), which contains all data from 
the one controller from the moment the archive was saved. Archives are stored in the 
particular gen-set folder of the particular site folder. See the picture in the chapter Using sites. 
In the quick connection mode the location where archives are stored can be selected by the 
user.  

 Archive set is a file with ".ast" extension, which contains links to archives from all active 

controllers in the site, that were saved at one moment using the function Save all or Save all 

as.... Archive sets can be saved in sites mode only and are stored in the particular site folder.  

 

Single Offline 

The single offline connection opens and displays one archive from one gen-set. 

1. Click to the button (1) to select the single offline connection. 
2. Select the gen-setin the list (2), from which you want to open an archive. 
3. Then select the desired archive in the list (3). The list contains all archives from the folder of 

the particular gen-set. 
4. If you are opening a quick offline connection, you have to select the folder, where your 

archives are located (4) and then select the archive from the list (3).  



 

InteliMonitor, SW version 3.0, ©ComAp – June 2013                                              27 
Intelimonitor-3.0-Reference guide.pdf 

 
SINGLE OFFLINE CONNECTION 

 
NOTE:  
The single-line diagram is not displayed in single offline connection.  
 

Multi Offline 

The multi offline connection opens and displays all archive from selected archive set. I.e. you will see 
data from all gensets which were saved in the same moment. 

1. Click to the button (1) to select the multi offline connection. 
2. Select the desired archive set in the list (2). 
3. Use the button (3) to export the selected archive set (i.e. the ".ast" file as well as the related 

archives) into one file, which is called "zipped" archive set. This file has ".zst" extension and is 
specially designed for sending to ComAp technical support if needed.  

NOTE:  
The multi offline connection is not available in the quick connection mode. 
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MULTI OFFLINE CONNECTION 

 

Users and password 

All ComAp controllers offer password protection for certain functions and adjustment points. In most 
cases the level of password protection for the particular function or setpoint is configurable using the 
PC configuration tool (GenConfig, WinEdit, LiteEdit). Please see the configuration tool manual or 
controller manual for details about password protection for the particular controller type. 

 IS-Classic, IG-Classic - there are three levels of password. If a valid password of certain level 
is entered, the user gets access to items that have configured the same or lower password 
level.  

 IL-NT, IC-NT - there is one level of password. If a valid password is entered, the user gets 
access to all protected items.  

 IGS-NT - there are seven different users and seven different access groups. Each user has 
access to selected groups and has own password. Each item, which is to be protected by 
password, belongs to one of these seven access groups. If a valid password is entered, the 
user gets access to all items that belong to a group to which he has granted access. The user 
#0 is an "Administrator" and has access to all protected items as well as the rights for 
managing other users.  

Entering password 
If the Sites connection mode is used, then the passwords for each controller can be entered in 
advance into the gen-sets list (see the chapter Create site). If the Quick connection mode is used, 
then the passwords for the particular controller can be entered before the connection is opened. 

Single connection: To enter the password while the connection is already running, go to the menu 

Monitor -> Enter password or click to the icon   . In case of IGS-NT you also have to select the 

user, for whom the password is beeing entered. 

Multiple connection: To enter the password while the connection is already running, in the toolbar 

select the gen-set to which you want enter the password and then go to the menu Monitor -> Enter 

password or use the item Enter password from the pull-down menu of the desired controller. In case 

of IGS-NT you also have to select the user, for whom the password is beeing entered. 
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Deactivating password 

Click to the icon   resp.   or use the menu item Monitor -> Deactivate password to 

deactivate the currently entered password (in case of IGS-NT log-out the current user). 

Manage users 
NOTE:  
This function is available in IGS-NT controllers only. 
 

Log-in as the administrator and click to the icon   or use the menu Monitor -> Admin users to 

open the window where you can manage the other users of the controller. 

1. Select the user that you want to edit in the list (2). The name of the user can be changed after 
clicking into the name field. The name of the currently selected user is indicated in the label 
(3).  

NOTE:  

To change user name and levels user must be enabled first in section (1). 

 

2. Select the top access level for this user by double-clicking on the appropriate rectangle in the 
access level map (4). All lower levels will be selected automatically. To select levels 
individually, hold the Ctrl key and click on level field.  

3. Uncheck the "Enabled" item (1) if you want to disable the selected user, i.e. the user will not 
have any access level assigned. 

4. You can reset password to default for all users except the administrator by clicking on the 
button (5) or reset password only for the selected user by clicking on the button (6).  

NOTE:  

Default password is "0" (zero). 

 

5. Enable/Disable function Password break protection function (7). Initial status is DISABLED.  

NOTE:  

Warning “PassInsertBlck” appears in alarm list when controller is blocked. It is not allowed to 
insert the password in case that controller is blocked. There is information that controller is 
blocked for next password attempt and time remaining till the end of blocation instead of 
password input window at the terminal screen. The controller is locked for 5 minutes when the 
password is 6 times wrong entered (in case of next 6 wrong attempts (correct password was 
not inserted at all) for 30, 60, 120, 240 minutes). Incorrect password message appears in the 
history of the controller when the invalid password is used.  
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MANAGE USERS WINDOW 

 

Browsing values 

The values window is used to display currently measured values (in online connections) or values 
measured at the moment of saving the archive (in offline connection). 

Click to the button   or go to the menu Monitor -> Values to open the Values window. If you are 

connected to multiple gen-sets, you have to select the requested genset first or use the item Values 

from the particular gen-set pulldown menu. 

 Yellow colour of the background indicates that there is an active protection of the level 1 (e.g. 
warning) or previously active protection which is still not confirmed for this particular value.  

 Red colour of the background indicates that there is an active protection of the level 2 (e.g. 
slow stop, shutdown etc.) or previously active protection which is still not confirmed for this 
particular value.  

 
VALUES WINDOW 
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Adjusting setpoints 

The setpoints window is used to displaying and/or adjust setpoints in the controller. The setpoints can 
be adjusted one by one manually or all setpoints can be imported at once from another archive. 

1. Click to the button   or go to the menu Monitor -> Setpoints to open the Setpoints 

window. If you are connected to multiple gen-sets, you have to select the requested genset 

first or use the item Setpoints from the particular gen-set pulldown menu.  

2. Select the setpoint group in the group list to display the setpoints located in the particular 
group. 

3. Double-click on the setpoint value to modify it. If the setpoint value has gray background, then 
the setpoint requires higher level password than the currently entered is.  

4. If a setpoint has yellow background, then it's value is out of allowed range and should be 
readjusted properly. This situation can occur after firmware upgrade.  

5. There are situations in which certain setpoints are fixed and can't be changed. Typically if you 
use a hardware modification which does not have the particular feature which is the setpoint 
related to. Such setpoints are gray with lightblue background. E.g. if you have IG-NT controller 
modification you can not switch the AC voltage inputs to 100V range as this controller 
modification supports only 277V.  

6. If the configuration is locked and administrator is not logged-in, then all setpoints belonging to 
the group 7 are displayed with gray background and there are star symbols displayed instead 
of the setpoint.  

7. The column Original setting contains the setting how it was in the moment the setpoints 

window was opened. If you want to restore this original setting doubleclick on the respective 
cell in this column.  

 
SETPOINTS WINDOW 
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Import setpoints 

The setpoints can be imported all at once from another archive. Use the menu Setpoints -> Open 

alternative setpoints and select the archive which you want the setpoints to be imported from. The 

alternative values will appear in a separate column of the setpoints window. 

 Use the menu Setpoints -> Import alternative setpoints to import all setpoints at once.  

 Double-click on an alternative setpoint to import the particular setpoint only. 

 
SETPOINTS WINDOW WITH THE ALTERNATIVE SETPOINTS COLUMN 

 

Use the menu Setpoints -> Close alternative setpoints to hide the column with alternative setpoints. 
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Multi-setpoints 
If you are connected to a site (i.e. multiple connection), you have an option to write selected setpoints 

into more controllers at once. This operation is called Multi-write setpoints. Use the menu Multi -> 

Multi setpoints to open the multi-setpoints window. 

1. From the list (1) select the controllers where you want to change setpoint(s).  

NOTE:  

It is possible to select more gensets at once. Click to the first genset you want to select 
(column "Genset"). Then press and hold shift key and click to the last genset you want to be 
selected. All gensets located between the two gensets will be selected.  

 

2. In the list (2) double-click to the controller, which will act as a "master", i.e. whose setpoints 
will be displayed in the right part of the window.  

3. Double-click onto a setpoint value to change it and write into all selected controllers. 
4. If you place the mouse pointer over a setpoint, the hint will show you current setting in all 

selected controllers (4) 

 If a setpoint is displayed in bold (3), that means it's setting is different in some of selected 
controllers. 

 If a setpoint is displayed in italic (6), that means the particular setpoint is not available in some 
of selected controllers. 

 
MULTI-SETPOINTS WINDOW 
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Browsing history 

Most of ComAp controllers contain a block in the non-volatile memory, where certain number of recent 
important events are stored together with their date/time of occurrence and important data recorded in 
the moment the event occurred. This memory block is called History. 

NOTE:  
See also the chapter History settings.  
 

Click to the button   or go to the menu Monitor -> History to open the History window. If you are 

connected to multiple gen-sets, you have to select the requested gen-set first or use the item History 

from the particular gen-set pulldown menu. 

 
HISTORY WINDOW 

If you are connected to a site (i.e. multiple connection), you have an option to see combined history 

from all controllers in one table. This is called Multi history. Use the menu Multi -> Multi history to 

open the multi-setpoints window. 

 
MULTI HISTORY WINDOW 
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Pre-mortem history 
The controller IS-NTC-BB contains a special memory buffer for cca 50 records of "pre-mortem" 
history. Every 3 seconds a new record is written into this buffer, whereas the latest record overwrites 
the oldest one. If a red alarm occurs (i.e. any alarm of 2nd level) the pre-mortem buffer, which 
contains at the moment records from last several minutes, is copied into the normal history file. 
InteliMonitor displays these pre-mortem records in italic on lightblue background and orders them just 
before the initiating event. 

 
PRE-MORTEM HISTORY 
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Remote switches 

The Remote switches window is used for control of the Remote switch outputs that are available in 
IGS-NT controllers. Click to the particular remote switch to change state of the respective controller 
output remotely. 

NOTE:  
The remote switch outputs are controlled via remote communication only and does not depend on the 
control loop of the controller, controller mode etc.  
 

 
REMOTE SWITCHES WINDOW 
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Control window 

The control window is used for control of the gen-set (controller) and fast overview of measured 
values, alarms, breaker position etc. 

Click to the button   or go to the menu Monitor -> Control to open the Control window. If you are 

connected to multiple gen-sets, you have to select the requested gen-set first or use the item Control 

from the particular gen-set pulldown menu. 

 
CONTROL WINDOW 
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Single-line diagram 

If InteliMonitor is currently connected to a site, i.e. the currently opened connection is multiple, the 
single-line diagram (multicontrol window) of the site is displayed on the background of the main 
InteliMonitor window. 

NOTE:  
The single-line diagram is displayed even if the particular site contains only one gen-set. If you want to 
see the single-line diagram in offline connection, you have to use Save all or Save all as for saving of 
the archive set (although you have actually one gen-set only) and then open Multioffline connection 
instead of single offline.  
 
The diagram shows a symbolic single-line schematic of the site, current status of the breakers, main 
gen-set values and others. It also provide control buttons for manual control of the gen-sets. 

 The diagram is stored in the default.cwd file, which is located in the site home directory. 

This name is obligatory even if the diagram is modified or created by the user.  

 The initial single-line diagram is created automatically according to the adjusted site 
properties and can be edited later with the Single line diagram editor.  

 If the single-line diagram was modified while connection to the particular site is opened, the 
single-line diagram can be then updated (file default.cwd is read from disk and applied) by 

right clicking to the SLD icon    

 The files related to the single-line diagram can be exported to a ZIP file and then imported 
again into another site or tranferred to another computer.  

 
AUTOMATICALLY GENERATED SINGLE LINE DIAGRAM EXAMPLE 
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CUSTOM SINGLE LINE DIAGRAM EXAMPLE IN SCADA MODE 

 

SCADA 

The single line diagram can be switched to fullscreen (SCADA) mode by the button   .The same 
button is used to switch the diagram back to normal mode. Switching back can be protected by 

numeric password (PIN). This feature is to activate in the menu Settings -> SCADA -> Fullscreen 

mode protected. 

There is a virtual keyboard available for SCADA mode. It is to be activated in the menu Settings -> 

SCADA -> Touch panel mode. The virual keyborad pops-up automatically whenever the operator 

clicks on any instrument where a numeric value is to be entered. This function is intended especially 
for touchscreen panels. 

The button   allows to open the multihistory window directly from SCADA without the need to go 
back to normal mode and open it from the main menu or toolbar. 
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Single-line diagram editor 

The single-line diagram editor (previously called muliticontrol window editor) is designed for creating 
user-specific single-line diagrams or for editing the automatically created diagrams. 

The editor is launched from the menu Tools -> Single line diagram editor. 

NOTE:  
If the editor is launched while a connection to a site is running, then the diagram of that site is 

automatically opened (file default.cwd from the site directory).  

 

Editor window 

 
EDITOR WINDOW 

 

 Toolbar - contains tabs with common objects and objects predefined for different types of 
controllers  

 Objects tree - contains tree of all objects and shows dependencies. An object can be 
selected by clicking on it in the tree.  

 Object properties - contains properies of the currently selected object. Most of properties can 
be edited here.  

 Drawing area - This area is used to create the drawing.  
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Diagram structure 

A diagram can be single-level or multi-level. 

 The basic level is the window itself (background), which is called Master grid in the Object 
tree.  

 Next level can be created by putting an object panel to the drawing. The main purpose of a 
panel is to group all objects related to one controller (= objects with the same address). A 
panel can be locked and then it behaves as an object, i.e. can be moved as one entity, but 
not edited. To edit a panel, you have to unlock it by double-clicking on the "lock" icon in the 
upper-left corner of the panel.  

 
DIAGRAM STRUCTURE 
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Editor menu 

File 

New drawing Creates a new drawing. Currently opened drawing will be closed. 

Load drawing from 

... 

Opens an existing drawing. If the editor is started while a connection to a 
site is running, then the drawing of that site is offered for editing by default.  

Save drawing to ... 

Saves current drawing to a file. The file, which has to be used as the single 
line diagram for a particular site, must be named default.cwd.  
NOTE:  
If you have edited an automatically created drawing or you have created 
one manually, it won't be owerwritten with a new automatically created 
drawing next time you will connect to the site. You will be asked before 
overwriting. Check the box (10) in the site properties dialog to avoid this 
question to appear again.  
 

Import drawing Imports a drawing from a file as a panel into the current drawing.  

Close drawing Closes the current drawing. 

Exit Exits the editor. 

Editor 

Clear drawing Delete all contents of the current drawing. 

Setup editor  

 

1. Select grid type. 
2. Adjust width in pixels, which is applied to newly created drawings. 
3. Adjust height in pixels, which is applied to newly created drawings. 
4. Check the box if you want the objects to be attached to the grid. 

NOTE:  
If you want to change size of the current drawing, select the Master grid object in 
the object tree (structure) and then change it's width and height in the property 
editor. See also desription of the editor window. 
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Editor toolbars 

 

 
The toolbar contains objects, that can be placed into your drawing. The objects are separated into 
tabs according to their meaning. 

 General tab contains objects that are common for all controller types.  

 Graphics tab contains pure graphic objects that do not have relation to controllers.  

 Custom tab contains general-purpose objects, that are not pre-adjusted to any specific 
purpose and can be used for various controller types and purposes.  

 All the remaining tabs contain objects that are specific to the particular controller type or 
general-purpose objects preadjusted to the paricular purpose and controller type.  

Editor functions 

Modify drawing 

If you want to modify the existing drawing of a particular site, open a connection to that site (can be 
also multi-offline) and then start the editor. The appropriate cwd file is then opened automatically and 
you do not need to search manually the proper cwd file in your sites directory structure. Once you 
have edited your drawing the automatic reendering will recognize this fact and you will be asked about 
overwriting of the edited drawing next time you will connect to that site. It is recommended to check 
the box (10) in the site properties dialog to avoid this question to appear repeatedly. 

Create new drawing 
A new drawing is created automatically after the editor is started or can be created manually using the 

menu item File -> New drawing. Size of the new created drawing is given by default values in the 

Editor setup. If you want to change size of the drawing, select the Master grid object in the object tree 
(structure) and then change it's width and height in the property editor. 

Import drawing 

An existing drawing can be imported as a panel to the currently edited drawing. Go to menu File -> 

Import drawing and select CWD file that you want to be imported. A new panel will be created in the 

current drawing and the contents of the imported file will be placed into the panel. 

Editing objects 
NOTE:  
If a panel is locked, it behaves as one object and can be moved, resized and other it's properties can 
be changed. To edit a panel, you have to unlock it by double-click on the "lock" icon. To lock the panel 
again, double-click on the "lock" icon again.  
 
Select an object: Click on the object in the drawing or select it in the object tree. 

Select multiple objects: Hold down CTRL key and select desired objects by clicking on them in the 
drawing or object tree.  

Select objects in a rectangular area: In the diagram draw a rectangle by mouse while holding left 
mouse button. 

Adding an object to the drawing: Select appropriate tab from the toolbar and select appropriate 
object. Then click to the drawing to place the object into the drawing. 
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Drawing line: Select the Line object, then click into the drawing to start the line, move the mouse to 
the next point of the line and click again to put the point to the drawing. Put next point the same way or 
finish the line by clicking of the right mouse button. 

Drawing rectangle or ellipse: Select the proper object then click into the drawing to put the upper left 
corner, move the mouse to desired position of the lower right corner and click to put the point to the 
drawing. 

Delete an object: Select the object and then press DEL key. 

Edit properties of an object: Select the object and then use the properties editor in the lower left 
corner of the editor window. 

Change structure, e.g. to move an object from one level (panel or base) to another one: go to object 
tree and drag the object to the desired level (panel or base). 

NOTE:  
If you move an object from one panel to another one (smaller), the moved object can be invisible, 
because it’s coordinates can be out of border of the destination panel. In that case you have to correct 
the coordinates manually in the Object inspector.  
 
Lock/unlock panel: Double click on the "lock" icon in the upper left corner. 

Move/resize object: Select the object and drag it to desired position or edit position/size properties. It 
is also possible to use arrow keys for fine position tuning (overrides grid adjustment) as well as CTRL 
+ arrow keys for movig in the grid. To resize object, drag one of resize marks located in corners to 
achieve requested size. 

NOTE:  
Sometimes it can occur that an object is not visible or visible only partially i.e. the object is outside the 
panel/window border. This can be caused by resizing of a panel/window or by editing the position/size 
manually. In such a case it is not possible to move the object by drag and drop. The position has to be 
corrected manually by editing of object position/size properties.  
 

Using clipboard 

It is possible to use standard windows clipboard operations for manipulation with the objects in the 
drawing. 

 CTRL+C copies the selected block into the clipboard. The object can be a panel (which can 
contain other objects) or a single object.  

 CTRL+X cuts the selected block from the drawing and puts it into the clipboard.  

 CTRL+V pastes the object from the clipoard into the drawing. If a panel is currently selected in 
the drawing, then the object is pasted into this panel, otherwise the object is pasted to the 
background (master grid).  
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Objects description 

Control buttons 
The object Control buttons is used for gen-set control. This panel is functionally equal to the respective 
panel on the controller front facia. 

Use the property Button type to select which buttons of the particular Control buttons object will be 

visible. This allows to place e.g. start/stop buttons to a different position than e.g. alarm reset button. 

 

 

Mode selector 

The Mode selector object is used for switching of the controller mode. The available items modes in 
the design time are default (OFF-MAN-AUT), but the object is automatically updated according to real 
available controller modes in the moment the connection is created. 

 

 

Status line 

The Status line object is used for displaying one of the controller status texts - the same texts that are 
also displayed on the controller main screen. 

 

 

The property Display data is used to select which status text will be displayed: engine status, breaker 

status or timer status. 

NOTE:  
Some controllers do not provide all of these status texts, e.g. InteliMains do not provide engine status. 
If the object is switched to nonexisting status text, an empty box will be displayed.  
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Alarmlist 

The object Alarmlist is equal to the alamlist on the controller screen. It displays up to 16 active and/or 
unconfirmed alarms. In IG-NT and IS-NT controllers this alarmlist contain both alarms read-out from 
an ECU unit as well as alarms issued by the controller itself. 

 

 
IC-NT and IL-NT controllers have separated alarmlist for ECU alarms. 

 

Line 

The Line object is used for drawing wires or for creating of any user graphic. 

Junction 
The Junction object is used for creation of a wire junction (connection). It can change its' color 
according to a single bit value. This feature can be used, together with the object Busbar, to animate 
whether a power line is under voltage or not. 
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Rectangle 
The Rectangle object is used to draw squares and rectangles. 

Ellipse 

The Ellipse object is used to draw circles and ellipses. 

Text 
The object Text is used to insert text into the drawing. Text color, text size and border color are 
adjustable. 

 

 

Panel 

The Panel object is a container for grouping objects of one controller. All the objects located in a panel 
take controller address property from the panel's property. In online mode if a controller is 

selected related panel is bordered by green line. This border can be disabled by the property Highlight 

enabled. 

The panel object can contain a background image (preferably png or jpg format). The image is 
placed into the upper-left corner and is neither stretched nor resized, i.e. it should be of the same size 
as the panel to fill the full panel area. 

If a panel is locked, it behaves as one object and can be moved, resized and other it's properties can 
be changed. To edit objects in the panel, you have to unlock it by double-click on the "lock" icon. To 
lock the panel again, double-click on the "lock" icon again. 

 
LOCKED AND UNLOCKED PANEL 
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PANEL OF THE SELECTED CONTROLLER IS BORDERED BY GREEN LINE 

 

Generator symbol 

This object is a symbolic image of a generator. 

Load symbol 
This object is a symbolic image of a load. 

Mains symbol 

This object is a symbolic image of a mains input (transformer). 

Engine symbol 
This object is a symbolic image of an engine. 
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Data grid 
This object is used for displaying of one or more values or setpoints from one controller in the form of 

a table. There is a general-purpose data grid available in the custom tab and there are data grids in 

the controller-related tabs preset to display most important values of the particular controller type. 

NOTE:  
The datagrid object can be used also as an analog gauge containing single value or as an adjuster for 
single setpoint. 

 

 The content of a datagrid is to be modified in the property Comm. objects.  

 There are properties to hide various parts of the datagrid as e.g. titles, value names etc. 

 It is possible to adjust font size and row height. This may be helpful to make the grid large if it 
is used for adjusting setpoints on touscreen panels.  
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Image 
This object is used to insert a custom image into the drawing. The image file should be located in the 
site directory (where also the file default.cwd is stored). 

Graphic element 

This object is a pair of image files. Which of the two images is currently displayed in the diagram is 
switched over by a single bit from any binary value. The both images must have identical resolution. 
The object is intended for using as instrumentation symbols, either static or animated. 

If the object is to be used as static symbol of an element (device) the property Image file name must 

contain the image file name and the properties for alternative image file name, communication object, 
controller address and bit index can be left empty. 

If the object is to be used as animated symbol of an element (device) the property Image file name 

must contain the image file name for logical 0 and Alt.img. file name for logical 1. The properties 

Comm.Obj for value and Bit index define the control bit that is used for switching over the two images. 

NOTE:  
There are several predefined image files, however new custom images can be added by te user as 
well. The directory, where all image files for the "Graphic element" object are stored, is fixed: 
c:\Documents and Settings\All Users\Documents\ComAp PC 

Suite\InteliMonitor\Graphic elements\ 

 

Analog bargraph 

The object Analog bargraph is a general-purpose object used for displaying of an analog value. The 
scale range is adjustable manually or is automatic according to the displayed communication object. It 
is possible to switch off various parts of the bargraph (e.g. scale, name etc.) and organize several 
bargraphs into one "multibargraph". 

 

 



 

InteliMonitor, SW version 3.0, ©ComAp – June 2013                                              51 
Intelimonitor-3.0-Reference guide.pdf 

Analog meter 

This object is used for displaying of an analog value. There is a general-purpose analog meter 

available in the custom tab and there are analog meters in the controller-related tabs preadjusted to 

display some typical values as e.g. gen-set power. 

 

 
The object has following specific properties: 

 

1 COMM. OBJ. FOR VALUE Number of the communication object whose value the meter 
will display. To select the communication object click on the 

button  ... , then select an archive from the appropriate 

controller and then select required value.  

2 AUTO SCALE If this property is set to true, then the minimal/maximal levels 
as well as lower/upper limit levels of the meter are adjusted 
to the lower/upper range of the communication object (1). 
The properties 4-12 are not functional.  

3 VALUE DIM The value name and dimension. It is set automatically from 
the communciation object according to the property 1 and 
does not need to be set manually.  

4 AUTO SCALE COMM. OBJ. If this property is set to a communication object (i.e. it is 
nonzero), then the the meter is adjusted fully automatically. 
The minimal level as well as lower limit level are set to 0, 
upper limit is set to current value of this communication 
object and maximal level is set a bit higher than the upper 
limit. The properties 5-12 are not functional.  

5 SCALE 0% Manually adjusted leftmost level of the meter's scale. 

6 SCALE 0% COMM. OBJ. If this property is set to a communication object (i.e. it is 
nonzero), then the leftmost level of the meter's scale is set 
to current value of this communication object. Property 5 is 
not functional.  
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7 SCALE 100% Manually adjusted rightmost level of the meter's scale. 

8 SCALE 100% COMM. OBJ. If this property is set to a communication object (i.e. it is 
nonzero), then the rightmost level of the meter's scale is set 
to current value of this communication object. Property 7 is 
not functional.  

9 LOWER LIMIT LEVEL Leftmost value of the "in range" area in the meter's scale. 

10 LOWER LIMIT LEVEL COMM. OBJ. If this property is set to a communication object (i.e. it is 
nonzero), then the leftmost level of the "in range" part of the 
scale is set to current value of this communication object. 
Property 9 is not functional.  

11 UPPER LIMIT LEVEL Rightmost value of the "in range" area in the meter's scale. 

12 UPPER LIMIT LEVEL COMM. OBJ. If this property is set to a communication object (i.e. it is 
nonzero), then the rightmost level of the "in range" part of 
the scale is set to current value of this communication 
object. Property 11 is not functional.  

13 UNDER LIMIT COLOR Color of the scale below the "in range" area. 

14 IN RANGE COLOR Color of the "in range" area. 

15 OVER LIMIT COLOR Color of the scale over the "in range" area. 

16 SCALE DENSITY This property adjusts into how many sectors the scale will 
be divided. It helps to get "round" numbers to the scale 
labels. Default scale density is 5, so if the scale range is e.g. 
180, the labels will be 0-36-72-108-144-180. Increasing the 
scale density to 6 will give rounded labels 0-30-60-90-120-
150-180  

 

NOTE:  
If the meter scale is not set manually, i.e. it is set according to a communication object range or value, 
the final scale is automatically updated to show "round" values.  
 

Switch 

The object Switch is used for visualization of a contact, breaker etc. There is a general-purpose switch 

available in the custom tab and there are predefined switches in the controller-related tabs for 

visualization of circuit breakers. 

 The general purpose switch is driven by a single bit. It requires a communication object and bit 
index to be set in it's properties. 

 The predefined switches are fixedly set to appropriate objects/bits. 

 Different colours can be assigned to closed and opened state. 
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Led 

The object Led is used for visualization of a contact, breaker or any other single-bit information. There 

is a general-purpose Led available in the custom tab and there are predefined Leds in the controller-

related tabs for visualization of circuit breakers and other status information. The predefined Leds are 
equal to the Leds on the controller fron facia. 

 The general purpose Led is driven by a single bit. It requires a communication object and bit 
index to be set in it's properties. 

 The predefined Leds are fixedly set to appropriate objects/bits. 

 

 

Remote switches 
The object Remote switches is used at IGS-NT controllers for remote control of binary outputs Remote 
Switch X. The object contains by default all 8 switches, however each switch within the object can be 
made hidden or visible separately. It is possible to have more Remote switches objects with identical 
controller address in one drawing. 

The property Show labels selects whether the object is displayed horizontally without labels or 

vertically with labels. 

NOTE:  
The labels can be changed using GenConfig (ver. 2.5 or higher). 
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Link 
This object is a button that shows user-defined text or image, which switches the single line diagram to 
another CWD file within the same site directory. 

The object is intended for creating more-level diagrams, e.g. one overview diagram and several other 
diarams with details of certain parts of the technology. The overview diagram contains links to the 
detail ones and these contain links back to the overview. 

 
PRINCIPLE OF LINK OBJECT 

 

Communication status 

The object indicates communication status of the DDE server with the particular controller. 
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Trend 

The object Trend is used to display trend line for any value. 

NOTE:  
Trend line is cleared when SCADA screen is changed. 
 
 

 

 

 

1 COMM. OBJ. FOR VALUE Number of the communication object whose value the meter will 

display. To select the communication object click on the button  ... , 

then select an archive from the appropriate controller and then select 
required value.  

2 TITLE Choose Title of Trend. 

3 RANGE Select Range (Lo and Hi limits) for displayed value. 

4 TIME RANGE Select Time range for X axis in minutes. This period is displayed in 
Trend. 

5 GRID DENSITY Select Grid density for X and Y axis. 
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Login 
The object Login is used to login into controllers. In properties it is possible define Login button only for 
one controller specified by its CAN address or into all available controllers. 

To login into all controllers by one button Login to all contr. in properties must be checked. Option "All" 

is than displayed in Controller addr. field instead controller address. When Login button with this 

setting is used in SCADA, system will try to login into all available controllers simultaneously. The 
same User/Password settings for all controllers is expected. 

If user is logged in into at least one controller, "Logout text" is displayed and icon is in orange color. If 
user is logged in into all available controllers, icon is in green color. 

NOTE:  

To display on screen keyboard to enter password, select "Touch panel mode" in InteliMonitor -> 

Settings -> SCADA.  

 
 

 

 

 
VIRTUAL KEYBOARD IN SCADA 
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Soft Key Command 

The SoftKeyCommand object is a instrument to assign a specific controller function and indicate 
status of the function by color of bar, text and picture. is a predefined list of available functions, such 
as engine start/stop, breaker open/close or the function can be assigned by it's command number and 
argument. Functionality of this object is very similar to the SoftKeyCommand implemented in 
InteliVision 5 and 8. 

As first, Data archive and Commands must be selected. For standard commands, Command number 

and Command argument are filled automatically. It is possible to use color indication - red, green and 

yellow colors are available. Proper source of binary signals must be selected in that case. Yellow color 
is displayed if enabled and Red and Green source bits are active.  

Also source for Active text  and Active image can be set to change it based on binary signal by Active 

Comm. obj.  parameter. If source is set to "0", active text and image is displayed if Red, Green or 

Yellow indication is active - this is the same functionality as on InteliVision 5 and 8. If any other source 
(binary value) is used for this parameter, active text and image is controlled by this binary value. Only 

text or image is displayed on the button regarding on setting Show image. 

 

 

SOFT KEY COMMAND 
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Main menu description 

'Connection' menu 

Open connection 

See the chapter Connection to the controller. 

Close connection 

Use the menu Connection -> Close connection or the toolbar button   to close the currently 

running connection. If the data have been changed, you will be asked if you want to save the archive. 

CAUTION!  
In online connection you will be asked about saving archive even if you saved it just before closing the 
connection. This is because the data from the controller change very fast and the saved archive would 
be different every second. So if you previously saved the archive (e.g. if you wanted to have an 

archive showing a specific phenomenon in the history) and then answer Yes to the question about 

saving archive, your previous archive will be overwritten!  
 

Save 

Use the menu Connection -> Save to save archive from the controller (single connection) or from the 

selected controller (multiple connection). 

 The archive is saved under present name. If there isn't any name assigned (first save after a 
connection has been created), the name is assigned automatically.  

 In a quick connection the destination folder can be selected by the user before saving. 

 In a "site" connection the destination folder is the respective genset folder within the sites 
structure.  

Save as 

Use the menu Connection -> Save as to save archive from the controller (single connection) or from 

the selected controller (multiple connection). 

 The user is prompted to enter the archive file name. The archive will further keep this file 
name and path until the "save as" function is used again.  

 The destination folder can be selected by the user before saving. 

Save all 

Use the menu Connection -> Save all to save an archive set, i.e. all archives and the .ast file. 

 This function is available in multiple connection only.  

 This function saves all archives under their present names as well as the archive set file (*.ast 
file). If the names are still not assigned, new names are assigned automatically.  

 The archives are saved to the respective genset folder within the sites structure, the archive 
set file is saved to the respective site folder.  

Save all as 

Use the menu Connection -> Save all as to save an archive set, i.e. all archives and the .ast file. 

 This function is available in multiple connection only.  
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 This function lets the user to select name for the archive set. The archives are saved under 
new automatically assigned names. Both archive set and archives will further keep these new 
names until the "save as" or "save all as" is performed again.  

 The archives are saved to the respective genset folder within the sites structure, the archive 
set file is saved to the respective site folder.  

Save archive(s) and send by e-mail 
This function helps you with sending current data to ComAp technical support by e-mail. Microsoft e-
mail client (Outlook, Outlook Express) is required for this operation. The function saves archive (in 
single connection) or archive set (in multiple connection), opens a new e-mail message and attaches 
the saved data to the message. E-mail recipient is preset to ComAp technical support. Please 
describe your problem into the e-mail body and then send the e-mail. 

'Monitor' menu 

Control 

See the chapter Working with InteliMonitor: Control window. 

Setpoints 
See the chapter Working with InteliMonitor: Setpoints. 

Values 

See the chapter Working with InteliMonitor: Values. 

History 

See the chapter Working with InteliMonitor: History. 

Remote switches 
See the chapter Working with InteliMonitor: Remote switches. 

Language selection 

This menu is used for selection of language in which all the controller texts as e.g. setpoint or value 
names will appear. The list contains only languages that are present in the controller. 

Set statistic 

Use the menu Set statistic to change or clear statistic counters in the controller. 

1. The column (1) contains current values of the statistic counters. 
2. Double-click to the column (2) to change value of a statistic counter. 
3. Click on the button (3) to write the new value of the particular counter into the controller. 
4. You can change value of all counters first and then write all counters at once by clicking on the 

button (5). 
5. You can also set all counters to zero by clicking on the button (4). 
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SET STATISTIC WINDOW 

 

Controller/Archive info 

Use this menu to get complete information about the controller and attached modules. The window 
also contains the Password decode number and serial number which both have to be sent to your 
distributor in order to retrieve the lost controller password. 

Export data 

Use the menu Export data to save selected kind of data into an excel sheet. 

1. Use the pulldown menu (1) to select the kind of data you want to be saved. 
2. Click on the button (2) to select a file name and save the data into this file. 

 
EXPORT DATA WINDOW 



 

InteliMonitor, SW version 3.0, ©ComAp – June 2013                                              61 
Intelimonitor-3.0-Reference guide.pdf 

Wiring assistant 
The wiring assistant is a unique function which helps with proper wiring of all AC voltage inputs and 
CT inputs. The function is designed as a wizard which step-by-step checks the connections and if 
there is a problem found it also suggests the solution. 

Wiring assistant checks folowing things:  

 Sequence and polarity of mains/bus voltage terminals 

 Sequence and polarity of generator voltage terminals 

 Assignment and polarity of CT inputs 

 

 

 
Following conditions must be fulfilled before the wiring assistent can be used:  

 The gen-set must be able to be started in MAN mode, it must provide voltage. 

 If the mains/bus terminal are used for mains voltage measurement, the mains voltage must be 
present. Otherwise mains voltage test is skipped.  

 The check must be performed in island mode, i.e. MCB must be open. 

 After the GCB has been closed there must be nonzero load at the gen-set. Knowledge of the 
load power factor is advantage.  

NOTE:  

If you do not know the power factor the program will use default value 0.95L. However, if 
default value is used and the real power factor is significantly different the wiring assistant may 
give incorrect results.  
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WARNING!  
Do not manipulate with voltage and current terminals while the gen-set is running. If there is a wiring 
problem detected by the wiring assistant always close the assistant, stop the gen-set and then fix the 
problem. Never try to fix any wiring problem while the gen-set is running or mains is connected.  
 
CAUTION!  
This assistant checks only wiring of the measuring inputs to the controller, it does not check proper 
wiring of the power lines to circuit breakers etc.  
 

Admin users 
See the chapter Working with InteliMonitor: Manage users. 

Change password 

Use the menu Change password to change your own password, i.e. password for the user that is 

currently logged in (IGS-NT) or to change password of the same level that the currently entered 
password is (other controllers). 

NOTE:  
IGS-NT: If you are user #0 (Administrator), you can reset password to default for other users in the 
Admin users window.  
 
NOTE:  
Other controllers: If the highest level password is currently entered, you can change also all lower 
level passwords. Select the level you want to change at the bottom of the change password dialog.  
 

Change access code 

Use the menu Change access code to change the access code, which is needed for any type of 

remote connection to the controller. 

NOTE:  
IGS-NT: This function is available only if user #0 (Administrator) is logged-in.  
 
NOTE:  
Other controllers: This function is available only if password of the highest level is currently entered.  
 

'Multi' menu 

Multicontrol 

See the chapter Working with InteliMonitor: Single-line diagram. 

Multisetpoints 
See the chapter Working with InteliMonitor: Multi-setpoints. 

Multihistory 
See the chapter Working with InteliMonitor: History. 
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Multilogin/logout 

Use the Multilogin menu item if you want to enter password/log-in user into all controllers at once. It is 

necessary for this function that user names and passwords in all controllers are identical. If they are 
not, you have to enter password/log-in user into each controller separately using the controller pull-
down menu. 

If there is a valid password entered or user logged-in in all controllers, you can use the Multilogout 

function to deactivate passwords or log-out users in all controllers at once. 

'Tools' menu 

GenConfig 

Use the menu Tools -> GenConfig to launch GenConfig, the IGS-NT configuration tool. If you have 

multiple connection GenConfig will be launched for the selected controller. You can also launch 
GenConfig from the gen-set pulldown menu. 

NOTE:  
This menu item is available for IGS-NT controllers only. 
 

Single-line diagram editor 

See the chapter Single-line diagram editor. 

'Settings' menu 

Settings 

Fonts settings 

 The listbox (1) can be used to select font, which will be used for the InteliMonitor texts as 
menus, dialog boxes, messages etc.  

 The listbox (2) can be used to select font, which will be used for the texts that are read from 
the archive (controller) as e.g. setpoint and value names, alarms, history reasons etc.  

 If the checkbox (3) is ticked (recommended setting) the charset will be selected automatically 
according to the selected controller language. Otherwise the charset adjusted above will be 
used.  

 Your preferred language can be selected in the listbox (4). The archives will be switched 
automatically to this language whenever they will contain it. If an archive will not contain the 
preffered language, it will be open in english.  

NOTE:  
It is recommended not to change font settings if possible, e.g. leave font as Arial and "Auto change 
charset" ticked. 
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FONT SETTINGS 

 

History settings 

This menu is used to adjust how InteliMonitor will handle the controller history. 

 Site monitored from this computer only - This option uses fast method of reading history. 
Use it if you monitor several sites with this computer only and you are sure, that there isn't any 

other computer which could connect to the same sites/gensets. Use the Explicit numbers 

field to specify, how many records you want to store for the particular genset.  

NOTE:  

If you adjust higher number of records than the controller capacity is, InteliMonitor will join 
history from consequent sessions to achieve the requested number of records. However, you 
have to connect regularly enough to avoid gaps in the joined history.  

 

 Site monitored from more computers - This method reads always all content of the 
controller history and is slower than the previous method. Use it if you are not sure about other 
possible computers that may connect to the controllers and if you want to keep more records 
than the controller capacity is. However, as in previous option, you have to connect often 
enough to avoid gaps in the history.  

 Service tool - This option always reads and displays exact image of the history records that 
are currently present in the controller. InteliMonitor does not combine history data from more 
sessions. This option is recommended for notebooks, laptops and all other computers, 
that are used for putting into operation or mainenance. 

 Monitoring tool - This option can be used to disable reading of history at all, if InteliMonitor is 
used e.g. for monitoring of one site and reading of the history is not requested there.  

 If you want to hide system records as e.g. terminal connected and disconnected, password 
typed or changed etc. check the item Hide system records.  
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HISTORY SETTINGS 

 

Active call settings 

This menu is used to adjust notifications of received active calls. 

 Tick the checkbox (1) if you want the InteliMonitor to popup a message when a new active call 
is received. 

 Tick the checkbox (2) if you want the InteliMonitor to send an e-mail when a new active call is 
received and tick the checkbox (3) if you want the received archive to be attached.  

 Fill-in your SMTP server name into the field (5) and optionally also fill-in SMTP login 
information into fields (6), (7) if the server requires it.  

 Enter a valid e-mail address into the field (8). This address will be used as sender address. 

 Optionally enter sender name into the field (9). If you want the controller name to be used as 
sender name, tick the checkbox (10).  

 
ACTIVE CALL SETTINGS 

 

Miscellaneous settings 

This menu is used to adjust some other settings, which do not belong to any specific category. 

 Tick the checkbox (1) if you want to move focus in the setpoints window automatically to the 
next setpoint when enter is pressed to confirm the new value of the previous setpoint.  
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 Check the box (2) if you want to display only relevant objects in the setpoints window. This 
option hide all setpoints which are not relevant on selected HW modification  

 In the field (3) you can change the path to your sites directory. Use this function e.g. if you 
need to have the sites on a company server to share it with other users. Otherwise, if it is not 
necessary, it is recommended to leave the default the path.  

 The field (4) can be used for redirection of the InteliMonitor temp directory into some other 
location that the default windows temp directory.  

NOTE:  

The content of the InteliMonitor temp directory must not be deleted while the program is 
running. Use the redirection if your default windows temp directory is automatically deleted 
e.g. after log-in into your company network.  

 

 Check the fields (5) if you are using the program for continuous monitoring of a site and you 
want InteliMonitor to be started and last connection recovered automatically after the 
computer has been restarted e.g. due to an utility fail. 

If you want to start InteliMonitor automatically after reboot, tick the checkbox "Run 
InteliMonitor at the system startup". This will just start InteliMonitor if "No automatic 
connection" is selected. 

If you want to recover last connection used before PC power lost, check "Automatic recovery". 

Option "Automatically connect to" opens connection to the SITE selected from the list. Last 
method of communication is used. 

Option "Fullscreen mode" opens InteliMonitor in Fullscreen Mode. It means SCADA fills whole 
space of monitor, no menus or status bar is displayed. 

 
MISCELLANEOUS SETTINGS 

 
NOTE:  
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The User dongle setup item is a customer-specific setting related to specific firmware branch and is 

not used for any other firmware branch.  
 

Sound settings 

This menu is used to adjust settings that concern sound notifications of alarms. The sound notification 
function allows the operator to be informed about newly occured alarms by playing a selected sound. 
The sound can be played once or in a loop. The sound can be silenced by a button in the toolbar. 

 Tick the checkbox (1) if you want the InteliMonitor to play a sound when an alarm occurs at 
any of controllers in the currently connected site. The sound is played again when a new 
alarm occurs.  

 The field (2) is used to select the sound (*.wav file) which will be played and to specify 
whether the sound will be played in a loop or just once.  

 The buttons (3) can be used to try the selected sound. 

 
SOUND SETTINGS 

 
 

SCADA 

This menu is used to adjust settings for SCADA 

 Tick the checkbox (1) if you want to have dialogue windows displayed in bigger format with 
on-screen keyboard. It is usefull when InteliMonitor/SCADA is running on touch display 
without external keyboard.  

 The field (2) is used to disable exit from full screen mode without entering the password. 
When SCADA is in full screen mode, all other items normally displayed in Windows (like task 
bar, status bar, menus etc) are hidden and only SCADA window itself is visible (also without 
window frame, menus etc). To switch SCADA back to normal mode, password is required if 
this option is used.  

Note:  
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This is basic the protection against switch SCADA off by mistake for example when touch 
screen panel without external keyboard is used. It is still possible switch between applications 
or close the SCADA using keyboard.  
 

 
SCADA SETTINGS 
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InteliMonitor toolbar 

The InteliMonitor toolbar changes it's appearance according to the conection type. 

 
INTELIMONITOR TOOLBAR IN SINGLE CONNECTION 

 

 
INTELIMONITOR TOOLBAR IN MULTIPLE CONNECTION 

 

COMMON TOOLBUTTONS 

   
Click to open a connection.  

   
Click to close the active connection. 

   

This button helps you with sending current data to ComAp technical support by e-mail. 
Microsoft e-mail client (Outlook, Outlook Express) is required for this operation. The 
function saves archive (in single connection) or archive set (in multiple connection), 
opens a new e-mail message and attaches the saved data to the message. E-mail 
recipient is preset to ComAp technical support. Please describe your problem into the e-
mail body and then send the e-mail.  

 

TOOLBUTTONS IN SINGLE CONNECTION 

   Click to show the Control window.  

   Click to show the Setpoints window.  

   Click to show the Values window.  

   Click to show the History window.  

   
Click to show the Cylinders window. This button is available only if cylinder temperature 
measurement is configured in the controller.  

   
Click to show the Remote switches window. This button is avaliable only if the particular 
controller supports remote switches function.  

   
Click to log-in a user (IGS-NT) or enter a password (other controllers). See also the 
chapter Users and password.  
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This button is displayed if an user is logged-in (IGS-NT) or shows the level of the 
currently entered password (other controllers). The name of the user is shown on the 
button. Click to the button to deactivate password/log-out the user.  

   
This button is displayed only for IGS-NT controllers if the user #0 (Administrator) is 
logged-in. Click to it to manage the users.  

 

TOOLBUTTONS IN MULTIPLE CONNECTION 

   

Click to hide all other windows and show the single-line diagram. 
Right-click to update the single-line diagram if it was modified in the 
Single line diagram editor.  

   Click to show the Multi-setpoints window.  

   Click to show the Multi-history window.  

   

This button is displayed if all controllers are locked. Click to it if you 
want to enter password/log-in user into all controllers at once. It is 
necessary for this function that user names and passwords in all 
controllers are identical. If they are not, you have to enter 
password/log-in user into each controller separately using the 
controller pull-down menu.  

   

This button is displayed if there is a valid password entered or user 
logged-in in all controllers. Click to this button to deactivate 
passwords or log-out users in all controllers at once.  

   

This button is displayed if there is a valid password entered or user 
logged-in in some controllers, but not all. Click to this button to 
deactivate passwords or log-out users in all controllers at once.  

   

This button is displayed if the audible notifications of alarms is 
enabled. Click to this button to silence the notification sound. If a new 
alarm occurs at any controller of the currently connected site the 
sound will be played again.  

   

Click to this button to select the particular controller and redirect the 

functions in the Monitor menu to this controller. Click to the arrow on 

the right side of the button to open the pull-down menu for this 
particular controller. See also the chapter Single vs. multiple 
connection.  
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DDE Server 

DDE Server provides the communication interface between PC and Controller. It is started 
automatically from the program in the moment of reading/writing of the configuration from/to the 
controller. Use ALT-TAB (Windows task switching) to view DDE server window.  

 Click on Last errors to see report of the last error message.  

 Click on Stop to pause the communication (not to close the connection). By this it is possible 

reduce required bandwith for communication for example during programming of another 
controller.  

 

 

 
CAUTION!  
DDE server is started and stopped automatically. Do not close it manually! 
 

DDE Server status 

Status of the DDE Server (Running / Preparing / Error) for each controller address is visible in the 
DDE server window. 

 

STATUS COLOR MEANING 
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Running green The connection is running, no problems occured 

Programming blue 
The DDE server is programming firmware or configuration into the 
controller. Progress in percent is shown in the status text field.  

Preparing yellow 
The DDE server is building-up the connection to the controller. This state 
may last from seconds up to several minutes depending on connetion 
type and number of connected controllers.  

Error red 
The connection failed. Use ALT-TAB, select DDE Server and press the 
"Last errors" button at the controller with appropriate address to see more 
information  

 

DDE Server error messages 

 

Timeout (continuous) 

Connected controller does not answer to DDE server requests. 
Probable reasons:  

 The controller is not connected or switched off 

 The communication cable is wrong 

 The COM port number is not correctly selected 

 Setpoints in the controller related to the communication are 
not correctly adjusted 

 The communication module in the controller is damaged 

Timeout (time to time) 
Occasional timeouts can be caused by overloading of your operating 
system 

TAPI: requested modem 
(#) not found 

The selected modem is not attached or properly installed 

TAPI: unavailable modem Communication port is beeing used by other communication device.  

TAPI: Line unexpectedly 
closed 

Modem is configured in Windows, but it is not connected or it is 
failed.  

TAPI: Can't create 
connection 

It is not possible to open connection. Probable reasons:  

 When "beeping" is audible during start of the connection, the 
line quality is bad or the other modem is not compatible with 
the originating one.  

 When busy tone is audible during start of connection, the 
destination number is busy or wrong. 

 When no tone is audible, no phone line is connected to the 
Modem 

Pop-up window with a 
message Can't open 
COM 

The selected COM port is occupied by other program or is not 
installed. Check if there is other program using the COM port running 
or select proper COM port  

 


